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Question

How do | create a FDL connection to a SIMATIC S5 95-U over PROFIBUS
for the SIMATIC NET OPC Server with the SIMATIC NET PC Software?

Answer

The instructions and notes listed in this document provide a detailed
answer to this question.
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Assignment of tasks

In this example a CP5611 is used, that implements FDL communication
over the OPC Server with a SIMATIC S5 95-U on PROFIBUS.

The method described in these instructions also applies to the
communications processors CP5613/14 (A2), CP5621, CP5511 and
CP5512.

Condition

It is assumed that one of the two following configuration tools is installed:

e NCMPC
NCM PC is supplied with the SIMATIC NET CD and allows you to
create PC projects and open STEP 7 projects. It is, however, not
possible to edit S7 blocks in the STEP 7 project with this software.

e STEP7
STEP 7 is a separate software package with which you can create S7-
400, S7-300 and PC projects. S7 blocks can be edited with this
software.

Only one of these tools can be installed.

In chapter 2 “Configuration of the PC station” is described the configuration
of PC station so that you can use the FDL communication over PROFIBUS
to exchange data between PC station and SIMATIC S5 95-U.
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2 Configuration of the PC station
After successful completion of the hardware and software installation of the
SIMATIC NET CD and the configuration tool and after restarting your
computer, you start NCM PC or STEP 7 with "Start - (in Windows XP: All
Programs->) SIMATIC - SIMATIC Manager or SIMATIC NCM PC
Manager or using the desktop icon of the same name.
Create a new project with "File > New".
Figure 2-1 giving the project a name
x|
|Jser projects |
MName I Storage path
@ Example F:\Program Files\SIEMENSASIMATIC MCMYS 7 profsE Rample
4| | »]
Name: Type:
|PC_Statiori [Frojeat |
I- _'_ Litrra
Storage location
|:\Program Files\SIEMENS\SIMATIC.NCM\S 7proi Browse... ]
corea ||
Confirm the project name you have entered (in the example: "PC_Station")
with OK. An empty STEP 7 or NCM PC project is then created.
V1.0 02.04.2008 4/32
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Figure 2-2 inserting the PC station

Fl SIMATIC NCM PC Manager - PC_Station = |D|5|
File Edit Insert PFLC Wiew Options Window Help

D23 &[G sl 2of7 55|

=]
=) ]

Press F1 to get Help. [ {CPS611{MPT) I 7

With the menu command "Insert - Station > SIMATIC PC Station", you
insert the PC station.

Figure 2-3 changing the name of the PC station

[ SIMATIC NCM PC Manager - PC_Station I =1 5]
File Edt [nsert PLC Yiew Options ‘Window Help

Dlco(2?| % |B@ dn| 2f= |

Press F1 to et Helo. ICPSATI(MPTY | 7
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Give the PC station you have just inserted the same name as your
computer (in the example: "PC_Station").

Now open the hardware configuration of the PC station by selecting the PC
station, then pressing the right mouse button and selecting "Open Project"

(STEP 7: "Open Object").

Figure 2-4 hardware configuration of the PC station

[ SIMATIC NCM PC Config - [PC_Station (Configuration) -- PC_Station] =10l x|
B% Stetion Edk Insert PLC Wiew Options Window Help 18] x|
Dl(e-2 (% & (e (@ 8wl

EE— Al ol

| | Eind: | ﬁﬂ ﬁﬂ

2

2 ]|

4 3]

5 PROFIBUS-PA

6 ol PROFINET 10

7 - % B, SIMATIC PC Stalion

S o

Index Madule Order number Fim.. | M..| C.

1 <

4 —

5

3

7

3 PROFIBUS-DP slaves for SIMATIC $7, M7, and C7
g |distributed rack)

10 -|

Press F1 to get Help.

%

&

You will see an empty rack. If you cannot see the hardware catalog, click

on the button marked in red.
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Figure 2-5 selecting the modules from the hardware catalog

E;':_SIMA'IIC NCM PC Config - [PC_Station {Configuration) -- PC_Station] - I Dlﬁl
Bl Station Edit Insert PLC View Options Window Help =181 %]
D@ % & =2 sl @] 28 el
E G — 3 L
I | frt | a
2
3
2 = ¥ FROFIBUS OP =
5 PROFIBUS-PA
3 33 PROFINET 10
7 =8 SIMATIC PC Station
8 - CP Industiial Ethemet
JED I - Il = ceeroreus
_’l_, CP 5411
I — CP 54122
CP541242H
5| o P = (] CP 5511
{5512
Index Module Order rumber Fim.. |M..|C. =L CP o6
1 = ... SW V6.0 5P4
2 Sw VB0 SPS
@] CP 5613 —
: o @ (] CP5613A2
@ (] CP56I3FO
13 & 1
7 @ CPseld =l
] BGK1 56114400 £
3 SIMATIC NET CP 5611 PROFIBUIS, 57 connections, DP ——
10 - master, DPV1, DP slave, PG functions, DP master class
~1  ||2. PCl bus, routing, SIMATIC NET CD 7/2001 SP5 ...
Press F1 to get Help. ' - cha 4

Now place your PC modules in this rack (for example by dragging them
from the hardware catalog).

If you use a CP5613/14 (A2) (or CP5511 or CP5512) you will select the
CP5613/14 (A2) (or CP5511 or CP5512) from the STEP7 hardware
catalog.

If you use a CP5611 A2 or CP5621 you will configure these modules as
CP5611.

The following dialog appears automatically after you insert the module in
the PC station.

V1.0 02.04.2008 7132
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Figure 2-6 address assignment dialog

Properties - PROFIBUS interface CP 5611 (R0/S9) ]

General Parameters ]

Ix

Addiess: IE > | If a subnet is selected,
the nest avalable address is suggested.

Subnet:

- nok networked -

Cocel_| _beb_|

Click on the button "New" to create a new PROFIBUS subnet. The property
view of the PROFIBUS subnet will open. Change to the register ,Network
Settings“and set the relevant bus parameters.

Figure 2-7 configuring bus parameters for PROFIBUS subnet

Properties - New subnet PROFIBUS |

General  Network Settings |

: Dptiors...
Highest PROFIBUIS
Address: 126 - " Change
Tranzmission Rate: 19.2 Kbps :I

9375 Khps

187.5 Kbps

500 Kb
Profile: DFP

Standard

Universal [DP/FMS])

User-Defined

Bus Parametess... |

Cancel | Help |
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Confirm the dialog with ,OK".

Figure 2-8 property view of the CP5611

Properties - PROFIBUS interface CP 5611 (R0/S9) x|

Genetal Parameters I

Address: {E3)
Highest address: 126
Transmizsion rate: 1.5 Mbps

Subnet:

== ok Aetveoiload - Mew... |

ot ||

Connect the CP5611 to the PROFIBUS subnet which you just have
configured or to a PROFIBUS subnet which already exist.

Close the property view of the CP5611 with ,OK*".
The configuration and networking of the CP5611 is finished now.

V1.0 02.04.2008
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B2 HW Konfig - PC_Station

Station Bearbeiten Einfigen Zielsystem Ansicht Extras Fenster Hife
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=101

D[22 (%] & (e skl B %8 M|

AMPc_station (Konfiguration) — FAQprojekt_IE_SR

(e

.Suciwnc ] it nﬂ

|‘
R 1

Profil: iSlandard |
¥ PROFIBUSDP a
222 PROFIBUS P4

4% PROFINET 10
=-E SIMATIC 300
o SIMATIC 400
Bl SIMATIC PC Based Control 300/4
=18, SIMATIC PC Station
[ Benutzer Applikation
[ Controller
&[] CPndustrial Ethenet

= | -l =] CP-PROFIBUS
CPE41
CP 5412 42 —
!]:Im] e CPE412A2H
. = CP 5511
Index | [1 Baugruppe Enmse= ) bkl des 4 cP512
= CPEB11
.. SWVB0SP4 4|
S\ WR N SPR
4 | »
5 28
5 <
7 Verbindungen, DP-Master,
5 DP-Slave, PG-Funktionen, Routing, ;I
Driicken Sie F1, um Hilfe zu erhalten, .I W 4

The module has now been placed in a slot in the rack. You can select any
slot. There are no restrictions.

Figure2-10 configuring the OPC server

[iZHw Konfig - PC_Station

Station Bearbeiten Einfgen Zielsystem Ansicht Extras Fenster Hilfe

D[(2+® (% & D2 sl @] % a2l

[ OPC Server

C_sStation {Konfiguration) -- FAQprojekt_IE_SR

J CP 5611

0

11
< |

-

Suchen: ] ﬂLﬂ
Brofit | Standard

= B¢ PROFIBUS-DP
PROFIBUS-PA
=22 PROFINET 10
= [l SIMATIC 300
@ SIMATIC 400
@ [l SIMATIC PC Based Control 30074
=8, SIMATIC PC Station
=1+ Benutzer Appliation
Applikation
=+ OPC Server
[ . swve0SP4
§ SwVEOSPS .

o

Index Baugruppe

Firrrweare

MPl-Adres:

q swvel..
] swWVB25P1...
] Controfler

{1 CP-Industrial Ethemet

OPC Server

VE.2.1

=] CP-PROFIBUS

CP 5411

P RAT2 &2

« of

e ] -2l Boud B D S

OPC Server «l1
OPC Server fir die Protokolle DP, -
FDL. FM5. S7[subnetziibergreifend).

ISO/TCP, SNMP, DP Master Klasse |

Dricken Sie F1, um Hilfe zu erhalten.
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Select the OPC server in the hardware catalog and then drag it to any slot.

Figure 2-11 button ,NetPro*

D[(2-[2 (% & Bl dles| [ =((32) a2l

Now open the NetPro program. Use the button marked red in the toolbar in
Figure 2-11 button ,NetPro“.

In NetPro you configure a FDL connection to exchange data between the
OPC server and the SIMATIC S5 95-U.

Figure 2-12 configuring the FDL connection in NetPro anlegen
iT

A& NetPro - [PC_Station {Netz) - C:\Programme\...\STproj\PC_Stati] =101 x|
B& etz Bearbedten | Einfugen Zielystem Ansicht Extras Fenster Hife =181 x|
S8 | @] teoewete  SmC Wyl t] ae|

# e

Crrlhl :I

|——=8id
s wiad
Auswahl der Netzobjekte

[ B PROFIBUSDP

2 PROFIBUSPA
& 52 PROFINET 10
-] Stationen
#- Subnetze

y | o

Partner ID [Partner [ve il

=

~| |PROFIBUS DPSlaves _—I
v[ ||derSIMATIC 57, M7
WETE T e T | |und C7 [dezentraler

Elink sina neie Warhind ma in das Varhinds imock shalla ain

Select the OPC server and choose the menu command "Insert 2> New
Connection" to create a new connection for the OPC server or right-click
the OPC server =2 ,Insert > New connection®.

V1.0
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Figure 2-13 insert a new connection in NetPro

x
r~ Connection Partres

=-[a] In the cument project
= &P PC_Station
-------- [Unspecified)
e Bl broadoast stations
- Bl mlticast stations
& In unknown project

Eroject | E

8 Statiore | Unspecified)
g Module |

o !

O\

2 '

S — Connection

[a)

w

g Type:

3

¥ Display properties Before inserting

| oK I Apply Cancel Help

Because the communication partner isn’'t configured in the same S7 project
like the PC station, you have to configure unspecified connection. In the
dialog box “Connection Partner you have to select ,Unspecified” for the
connection partner.

Des Weiteren wahlen Sie den Verbindungstyp ,FDL-Verbindung* aus.

Click on the button ,Apply” so that the property view of the FDL connection
will open.
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Figure 2-14 property view FDL connection > register ,General Information*

x
General Information I Addiesses | Options| OPC | Qverview |

~ Local Endpoint

Name (ID): F[ZIL Conneclion]
ViaCP:  |CP5611

Houte. .. |

coud_| _ter

Insert a name for the FDL connection. Following change to the register
"Addresses".

Figure 2-15 property view FDL connection - register ,Addresses”
Properties - FOL connection

General Informaion ~ Addresses | Options| OPC |  Dverview |

Tes

Dezcrbes the addresz parameters of the local endpoint of an
FDL-connection.

Local Remote
PROFIBUS 2 |1 0
address:
LSAP: T [ =]
r- Free l& Vel 2 accees

Ok | Cancel Help

For “Remote” set the PROFIBUS address of the SIMATIC S5 95-U.

Following set the LSAPs for ,Local“ and ,Remote“. That's neccessary to
uniquely identify the FDL connection between PC station and SIMATIC S5
95-U.

V1.0
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The following LSAP rules have to be considered in a connection project

with a SIMATIC S5 95-U:

e J|ocal LSAP:
PROFIBUS address of the partner + 1

e remote LSAP
local PROFIBUS address + 1

These settings are set by the S5-95U. They must be taken into account.

You will have to consider the indication of the PROFIBUS addresses and
LSAPs if you configure the FDL connection in the S5 station.

Change to the register ,OPC-Properties".

Figure 2-16 property view - register ,OPC-Property“

Properties - FDL connection al | x|

General Infarmation ] Addresses |[Iptliu:|ns DPC'FTDDB"“%I Owerview |

Job timeout: IIEDEIIJ ms

Max. rumber of send relies:

T

Send buffer size: 240 Butes

Max. number of parallel send jobs:

1

Number of resowces for ndications:

(I‘ Send with higher pli:uity]

Caresl_| i

Deactivate the function ,,Send with higher priority“, because the SIMATIC
S5 95-U doesn’t support a high sending priority. The size of the send buffer
is up to a maximum of 240 Byte for a SIMATIC S5 95-U.

Apply the settings with ,OK".

If you select the OPC server in the PC station you will see the FDL
connection which you have just configured in the connection table of the
PC station.

V1.0
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Figure 2-17 connection table

"é-:ﬁelPru - [PC_station (Network) -- C:\Program Files\...\S7proj\PC_Stati]
? Metwork Edit Insert PLC Miew Options Window Help

=[8 (%) 8| (e dblul 8 5] B

s

se Ise

M
2

Selection of the network

= S5 PROFIBUS DP
::; PROFIBUS-PA

+ -5 PROFINET 10

-0 Stations

(] Subnets

|FOL Connection]

%
_ILI PROFIBUS-DP slaves for SIMATIC  —
»

4 | 57, M7, and C7 (distibuted rack])

Ready IPC inkemal (local) (X 268 ¥ 159 [Chg /|

Now the configuration of the of the FDL connection is finished.

Check the network settings referring transmission rate and bus profile.
Therefore in NetPro right-click the PROFIBUS subnet which is assigned to
the CP5611. Open the object properties of the PROFIBUS subnet.

Figure 2-18 opening object properties of the PROFIBUS subnet

'l"'&;gh‘.etPro - [PC_Station (Network) -- C:'Program Files',...\S7proj\PC_Stati] .=.LE|.L?
A Network Edt Insert PLC View Options Window Help =8
S[9 % & Ble bl 8 g2 Dzt |
PROFIBUS(1) B EF
PROFIBUS Eind: I n:], .
Y Copy Ctr+C '
| Selection of the network
Delete Del
PC_Station _ = B PROFIBUS DP
e _CP Print parameters... ﬁ PROFIBLS-PA
Server [5611 e —— ® PROFINET 10
B -] Stations
L Q ... Alt+Return @] Subnets

2

v
4| | »

Station |l'lﬂrfac:e|Address|Device rurber|
PC_Station CP 5611 2 -

£,
PROFIBUS-DP slaves for SIMATIC  —
57. M7, and C7 [distibuted rack)

Nisnlave nrnnerties nf the <elected ahieck for editinn. IpCinternal flacalt [ 221 ¥ 41 Che
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In the object properties of the PROFIBUS subnet change to the register
Network Settings"“. Select the profile ,User Defined" and click the button
,Bus Parameters...“.

Figure 2-19 property view of the PROFIBUS subnet

Properties - PROFIBUS X

General MNetwork Selfings |

e plions. .
Highest PROFIBUS ﬂ—l
Bddiess I 126 T [ D’laﬁgﬁ
Transmission Fate: 4545 [31.25) Kbps ]

93,75 Kbps
197 5 Kbps _I
500 Kbps
2 Mhne LI
Profie: DP
Standard
Lo, INini=F, = ¥[=]
Buz Parameters... |
Coce_|_ o |

The bus parameters are forced by the SIMATIC S5-95U. In the PC station
you have to adapt the bus parameters according to this presetting.

Table 2-1 bus parameters forced by the SIMATIC S5 95-U

baud rate in 9,6 19,2 93,75 187,5 500 1500
kBit/s

bus parameter

in bit times
Tset 10 15 45 80 80 80
Tslot 100 170 240 400 1000 3000
Min. Tsdr 12 15 45 80 80 150
Max. Tsdr 60 65 200 360 360 980

The baud rate is 1500 kBit/s in this example.

Click the button ,Recalculate” to define the parameters which are missing.

V1.0
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Figure 2-20 dialog ,bus parameter*

_x
Bus Parameters |
IV Tum on cyclic: distribution of the bus parameters
shot_Init | 3000 b Tslot 3000 ¢ bit
Max. T sdi: | 98@3: t_bit Tid2: 980 |_bit
Min.Tsd: | 1503: L_bit Trdy: 150 ¢_bit
sel: | 8[!3: t_bit Tidl: 195 t_bit
Tqur | [33: t_bit Thr: 84668  t_bit
= 56.4 ms
Gap Factor: 0= Tir typically: 15268 1_bit
= 10.2 ms
Retry lmit: 12
o Watchdog:
202437 bt
= 135.0 ms
Recalculate |

oK ] Cancel |  Hep |

After you have adapted the bus parameters close the dialog with ,OK".

Save and compile the S7 project. Therefore select the PC station in NetPro
and click the button ,Save and Compile” in the toolbar. This updates the
information in the S7 project.

Figure 2-21 Save and compile

x4
~Compie-
(+ [Compile and check everything
" Compile changes gnly

oK Cancel Hep |

NOTE Warning indications can be displayed while proceeding with the “Save
and Compile” of a S7 project. Warnings serve as piece of information and
have no functional effect. In case error warnings occur, search for
possible divergences in the previous steps of the instructions.
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Download the configuration into PC station

Open the ,Station Configuration Editor” in the Windows START Menu >
LStation Configuration Editor” or with the following button in the Windows
task bar.

Figure 3-1 button ,Station Configuration Editor*

Figure 3-2 Station Configuration Editor

Components | Diagnostics | Configuration Irfo |

I

Statior:  PC_Station Mode: AUN_P
Index | Name | Type | Ring | Status | Aun/Stop | Conn | <
2
3
4
5
6
7
s p—
El
10
1
12
13
14
15
16
1 =
|I~Ia; d_ieﬁsﬁc enfry an}vad!
Add... I Edit | Delete | Hing N |
Station Name... | (" Import Station .. ) Disatle Station _ |
Help

Click the button "Import Station...“. A message about restarting the PC
station will open.

02.04.2008 18/32
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Figure 3-3 message about restarting the PC station

Station Configuration Editor

= The station will be restarted,
J,r" i\ - Make sure that no communication iz active over the
" el

componernts involved,
Do pou want to import the station?

Entry-ID: 16705498

X]

| Yes || L No

Confirm the message about restarting the PC station with ,Yes". The
following dialog to select the XDB file, which should be import, opens.

Figure 3-4 selecting the XDB file

mporconiie 20
Look jn: | 3 XDBs x| « @ cF -
=1 (& Desktop
=t u My Documents

,_-1 My Cornputer
S 3% Floppy (&)
e SYSTEM [C)
) Program Files
) SIEMENS
) SIMATICNCH
) 57pmoy
|- PC_Stati
Fiagunel & 5 Open I
. e DATA (D)
Flesoft) o win2X () ol e |

In this dialog you enter the path of the XDB file. The XDB file is always
created in the project by NCM PC / STEP 7 (see Figure 2-1 giving the
project a name). With the combo box ,,Search in: “you navigate in the path

of the XDB file.

V1.0
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Figure 3-5 Information from the XDB file

Configuration for x0B Import |
Index | Name | Type | Status | Ener |~
1
2 [] oPCSewver  OPCServer
3
4
a5
3
T 1
a —
g ¥ cpsen CP 5611
10
1
12
13
14
15
e ll

@ The XDB import is possible. Refer to the list above for the configuration,

[ Waork in offfine mode [a downdoad to this station is then not possible)

Concel | Hep |

As information, you can see once again which modules and applications
are configured in the XDB file.
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Station Configuration Editor - [ONLINE] x|
Components | Diagnastics | Configuration Info |
Statior:  |PC_Station Mode: RUN_P
Index | Nare | Type Ring | Ststus | Run/Stop | Corn N
1
2 [] OPCSewer OFC Server 53 v
3
4
5
B
7
3 |
g IF cPsen CF 5611 B B
10
1
12
13
14
15
16
17 d
Mew diagnostic entry anved!
Add.. | Edt | peete. | Araon |
Station Name... | Impon Station... | Disable Station _ |
teb |

Now the import of the XDB file is finished and the configuration is

downloaded.

In the column connection, which is marked red, you see that the connection

is also been downloaded.

So the configuration of the PC station is finished.

V1.0 02.04.2008
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Configuration of the SIMATIC S5

Initialize the PROFIBUS Interface of the SIMATIC S5 95-U and
create a PLC-to-PLC link
Start STEP 5 clicking Start > SIMATIC > STEP 5.

Create a new S5 project file e.g. AGO5U@ST.S5D press on ,File > Project
- Adjust > Modules.

Connect yourself to the PLC with the mode ,,Online*“ press on ,File >
Project > Adjust > AG"“.

Transfer the modules FB252 and FB253 from the PLC to the S5 program
file "AG95U@ST.S5D" with "File = Modules = Transfer ".

Starting the configuration tool COM DB1 press on ,Switch - COM DB1".

Choose the language of the program with ,F* keys.

Assign a MLFB number to the dialog box that has appeared.

Enter the S5 filename in which the configuration data block will be
transferred later.

Figure 4-1 presetting for the configuration of the interface

[cAlsTER 5 ]

Defaults SIMATIC S5/CO0M DBA

Online/0ffline:

Order Mo.:
PLC rew. lewel:

Drive: L Program file:
Drive: Printer file:

Drive: Footer file:

Drive: Output file:

Adopt the settings with ,F6".

In the next dialog all parameters will be shown. Select ,SINEC L2" and
confirm you choice with ,Return®.
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Figure 4-2 possible configurations: SINEC L2
=10]

verview table ) SIMATIC 55/C0M DEB1

Permissible parameter blocks Settings

Onboard interrupt Parameterized(default)
Onboard counter Parameterized(default)
Onboard analog inputs Parameterized(default)
SIMEC L1 Mot parameterized

Timer function block Parameterized(default)

Clock parameters Hot parameterized

pedependent parameters Parameterized(default)
SIHEC L2 Hot parameterized

rror return Hot parameterized

Select ,Basic parameters” from the authorized parameters and confirm it
with ,Return®.

Figure 4-3 possible configurations: Basic parameters

Uverview table SINEC L2 SIMATIC S5/C0M DB1

Permissible parameter blocks Settings

parameterized

CONNECL LON parameterized

PLE link parameterized

Cyclic I70 - master parameterized
Cyclic I70 - slave parameterized
FHA services parameterized

Layer 2 services parameterized

The ,Basic parameters” include the configuration of the bus parameter and
the definition of the PROFIBUS address (Own station address) for the
SIMATIC S5.
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In order that the data are exchanged between SIMATIC and PC station you
have to set the ,Own station status” to ,active"“.

The bus parameters were set in NetPro. Adopt the setting from Figure 2-19
and Figure 2-20.

Figure 4-4 Basic parameters

SIHEC L? basic parameters SIMATIC S5/COM DB1

Own station address:
Own station status:

Baud rate:

Highest station address on bus:

Target rotation time:
Set-up time:

$lot time:

Shortest delay time:

Longest delay time:

Adopt the ,Basic parameters” with ,F6".

Select ,PLC-to-PLC link" and confirm it with ,Return®.
Figure 4-5 PLC-to-PLC link

rview table SIMEC L2 SIMATIE S5/7C0M DET

Permissible parameter blocks Settings

Basic parameters Parameterized
ndasd _coooact 1on i parametlerized
PLC-to-PLC Link) parameterized
(13§13 I = master parameterized
Cyclic I/70 - slave parameterized
FMA services parameterized

Layer 2 services parameterized
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In the first column ,PLC-PLC link to station" you have to select the row with
the PROFIBUS address of the PC station. In this example the PROFIBUS
address of the PC station is ,,2".

In the row, which you have selected, set two status bytes for the indication
of the PLC-PLC link.

Because the SAPs are uniquely defined by the PROFIBUS addresses of
the PC station and SIMATIC S5 it's not possible to edit the local and
remote SAP.

Figure 4-6 configuring PLC-PLC link
SIHEC L2 PLC-to-PLC link ) SIMATIC S5/C0OM DEBA
Own station address 10/ Station active
PLC-PLC Status byte

link to S
station Receive Length byte

(5 | Mg Il | Me rIW | Me 22 1 3 | 11 )

I N .
ME ME
ME ME
ME ME
ME MB
ME MEB
MB MEB

Adopt the setting with ,F6"“.
Leave the interface configuration with ,F8“.

Saving the configuration which you have created with ,F3 — DB1
transferred®.

Following transfer the DBL1 to the S5 project file which you have selected
with ,F1 — Transfer to FD".

Switch back to STEP 5 with ,ESC*.

4.2 Description of the S5 program
Open the DB1 which was created by the configuration tool COM DB1. The
configuration appears.
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Figure 4-7 configuration block DB1

‘DB1 SL2: TLH 10 SThA AKT °;
‘BDR 1500 HSA 126 TRT 295°;
‘24 SET 1 ST 300 SDT 1 11°;
* 80T 2 150 STBS 2 MB2D §°
“TBR 2 MB21 ; EHD";

moammammn

Adopt the setting with ,F7*.

NOTICE  |t’s not allowed to change the DB1 with STEP 5. All changes have to
be making with the configuration tool COM DB1.

Copyright © Siemens AG 2008 All rights reserved
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Call the blocks L2-SEND and L2-RECEIVE in the OB1
Create the OB1.

Build a VKE = 1 with the following commands:

e OMO0.0

e ON MO0.0

Call the function block FB252 ,L2-SEND" (see Figure 4-8).

Build a VKE = 1 with the following commands:

e OMO0.0

e ON MO0.0

Following call the function block FB253 ,L2-RECEIVE" (see Figure 4-8).
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NOTE The function blocks L2-SEND and L2-RECV are executed only when
VKE = 1 prior to the call.

The length of the send area is specified in words (parameter: QLAE =5
- 5 words).

If the length of the receive area is preset with ,-1“the length of the data
will detect automatically (parameter: ZLAE = -1).

Saving OB1 with ,F7“.

Creating the send and receive buffer

Because the send and receive buffer must be located in DB10, this must be
created in the project and declared with an adequate length.

Then download the entire program to the S5 station.
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Start of the OPC-Scout

Start the OPC Scout with "Start - SIMATIC - SIMATIC NET - OPC
Scout".

Double-click the ,OPC.SimaticNet“for connection with the SIMATIC NET
OPC server. In the dialog that appears, enter a suitable group name and
confirm this with OK.

Figure 5-1 connecting with the OPC server and enter a group name

[rjoPC Scout - New Project1

File Ywew Server 7

| 8| 5| [ 2

|Servers and groups Jltemns incl. status information
=g Serveils) Itern Names | Value | Format
= 5 Local Serverds) 1
= 4 OFC.SimalicNET
\Q [M e aeoiand
S Rncacow
g gﬁ — Group Propetties:
= 84 Remote Enter a Group Mame"
gy Add [FOL
Create new group active rd
Requested update rats in ms |EDD 1'
Suscessiully connes
™ Estended ok Cancel | Apply |

Double-click the OPC group which you have created. The "OPC-Navigator"
opens. You will now see your protocols in the OPC-Navigator. Double-click
on "FDL". The connection name you configured in NetPro appears.
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EDPE-Havigatur
Nodes

Leaves

=] Connections
[+ gl DX
@& \DP2
#& \DF;
= WFDL:
=@ ICP 561

- gy WFMS:
[+ gl \WPNID:
[+ B \ST
#& LSHNMP:
#& ‘SR

+ @& FOL Connectionl

| tem Nam... | Basi

[\FDL: is selected

Double-click the FDL connection to define new items and add existing
items respectively for the communication.

In the OPC-Navigator select "send". In the middle section appears an item.
Move this "send" item to the right section with the button "->".

Double-click the ,send“item in the right section.

Figure 5-3 adding the ,send" item

x|
Modes TEaves Tizm Nam. | [Bass I DrgName | |Thekt&:|lﬁ'l"sivﬂ added to Group:
=& Connections T send  FDLIFDL. FDL{FDL Conn.. FOL:[FDL Connection] Jsend
[+ @@ D=
& @ \DP2
[+ @ \DP:
-l x
=@ ICP 5611 Enter an Rem with the following Syntax
=i FOL Connection] . -3 |
i send [Devicenamelltemname
@ @ receive - - < |
o @ sases FDLlFDL Connection Jsend =
[ B \FMS: - |
G \PHID: Madify Item Cancel
@& ST
o @y \SNMP: JEnter an tem
[ g \SR:
e [ ok | cocel |
['send s selected [1726/2004 [B:20 M 2
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Change the name of the ,send“item (see Figure 5-4 changing the name of
.send” item) and click the button "Modify Item".

Figure 5-4 changing the name of ,send" item

EMudify an Item i

Enter an iterm with the following Syntas:

[Devicenamelitemname

kg

|FDL:[FDL Connection] jsend10.80,10

Maodify ltem Cancel

[Enter an ltem

button ">".
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Following click the button “OK”.

Figure 5-5 adding the ,receive” item

[} oPC-Navigator

Nodes

= % Connections
[+ & DX
[+ @& \DPZ:
[+ @& \DP-
B \FDL:
[+ IICP 5611
=i FOL Connection
& send
i receive
- aliases
AFMS:
APMIO:
WS
ASMMP:
ASR:

=
=
=
&
&

Leaves Item Marm... | Basis

Orghame

2 receive  FOL[FDL.. FDL[FOL Conn...

The item "... send 10, ..." means, that a send buffer of 10 Bytes is
reserved on the PC station.

In the OPC-Navigator select "receive". Move the existing “receive” item
which appears in the middle section to the list in the right section with the

The listed ltemis) vill be added to Group:

FOL:[FDL Connection] receive
FOL:[FOL Connection]send10,B0.10

fer |

0K | Concel |

| teceive is selected

[1/26/2004 [ B418M

The items are added in the OPC Scout. If the quality is good the connection
is established and it's possible to read and write the items respectively.
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Figure 5-6 OPC-Scout

File V¥iew Server Group Item 7

=| 8 8| [&2[¥ el +-

|Servers and groups Items incl. status information
= ga Serveils) item N [ Value | Format | Type | Access | Quality
= % chd Serveils) 1 |FDLJFDL ConnectionlJsend10,80,10  {DIDIOI0INIDION Original uints[ ] RwW good
= 4g# OPC.SimaticNET 2 | FDL{FDL Connectionl jeceive ADIDNNOIOICION Original uintd[ ] R good
3

) [New group)

& OPC.SimaticNET.DP

£ OPC.SimaticNET.PD

85 ProfiDrive ProfilServer
= é Remote Server(s)

\Q Add Remote Servers(s)

Double-click the column value of the "send" item to write values to the send
buffer.

Figure 5-7 writing values

[5] write value(s) to the Item(s) X

Valye
A EETTEGIRIERE ]

~ Formatconversion——— & Sync wite
" Original [ Async wiite
r ' o
T Binary
oK. Cancel Apply

The default structure of the value input {0|0} must not be modified. Only the
values themselves may be modifying {1|1}.

Figure 5-8 successful write job

! ltem Names | Value frite Resul Error

1 EFDL:FDL-Verbirdun-‘lreceive 10011121 3(1-

The operation completed successfully
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With the services send and receive successful writing of data must be
checked in the columns ,Write Result* and ,Error”. The columns ,\Write
Result" and ,Error can be made visible in the ,View - Options" menu.
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